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About This Manual

What?

This manual was designed to help you navigate
through the process of creating a Portable
Document Format (PDF). You may use the
contents of this manual to translate a
PageMaker file including text, photographs, and
other graphics. The PDF file is an excellent
format to use for a class project, on a web page,
or for distribution by e-mail.

Why?

When you create a PDF with your Macintosh,
you no longer have to worry about whether it
will display differently on another person’s PC.
The PDF file keeps all your graphics and fonts,
and displays them identically on both Windows
and Macintosh platforms. Your font, your
photos, and your layout remain unchanged. The
PDF also compresses data by as much as 10%,
making a smaller file which is easier to down-
load off the Web or to send by e-mail.

When?

If this is the first time you have created a PDF,
you should be inspecting a finished product in
just under an hour. Although it may seem
complicated at first, once you become familiar
with the process, you can create a PDF in less
than 5 minutes. If you are a first-time user, it
may help to download and print this manual.
Keep it beside you as you follow the step-by-
step guidelines.

Where?

The manual is written for a Macintosh com-
puter with PageMaker installed. If you are
running a Windows-based program, you may
find that, with minor adjustments, the instruc-

tions work for you as well, but it is written for
the Macintosh.

How?

You will do most of your work in PageMaker
as you move from screen to screen, indicating
your preferences for the document you are
creating. After you have set preferences, you
will use PageMaker to complete a postscript
file, and then use Acrobat Distiller to translate
that file into a PDF. With Acrobat Reader, you
view the completed PDF file. This manual
follows that same process, with sequentially-
ordered chapters in PageMaker, Distiller and
Reader activities.

Who?

Whether you are just beginning or an old hand
with PageMaker, you can follow the processes
in this manual. The numbered steps in each
chapter take you through the process. More
experienced users may want to study the elabo-
rations offered in “Tips,” highlighted by a
picture of a lighthouse. Even more advanced
tips are included in the Appendix.

What if?

The manual addresses many “what if” sce-
narios. Help is available in Chapter 5 - Trouble-
shooting, which contains commonly asked
questions and answers. A Glossary is included
for unfamiliar terms, and an Index lists topics
of interest. (If you are viewing the document
online, you may discover that both the Table of
Contents and the Index contain hyperlinks to
take you directly to the topic you are seeking.)
If you cannot find answers to your questions
here, utilize the Help Menu in the PageMaker
software.
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Go to the Apple Menu, and scroll down to Chooser. Select PSP – Virtual Postscript
Printer.

3.  Select a Postscript Printer

1.  Check Your Software

Software Required: Mac OS, PageMaker, Acrobat Distiller, and Acrobat Reader

4.  Open Your PageMaker File
Open the PageMaker File you wish to use to create your PDF.

Getting Started

2.  Determine Report Parameters

Decide your paper size. Decide your design, will your PDF read like a book with
facing pages, or like a standard report?

Figure 1-1: Chooser
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1.  Under the File menu in PageMaker, scroll down to Printer Style, and to Define.
The Define Printer Styles Box will open.

2.  Click on New to create a printer style for your document.

Working with PageMaker

Defining Printer Styles

Type Name Here

TIP:  Once you have created your printer style, you do not have to create a new
style each time you create a new pdf. Simply select the name of the Style in the list
and click O.K.

3.  Give your printer style a name and click ok.

4.  This will return you to the Define Printer Styles Box.

When you create a PDF from PageMaker, you control the final appearance of your
project by working with screens to select your preferences. In this section, you may
choose a number of options such as paper size, project format, and orientation.

Figure 2-1: Define Printer Styles

Figure 2-2: Name Printer Style
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5.  Click on Edit. This will bring up the next screen, the Print Document screen.

1.  Standard settings should read as follows –  Printer: Virtual Printer; PPD:
Acrobat Distiller (PPD); Copies, 1.

2.  In the section marked Pages, select All and Print Both pages to print all pages
in your PDF.

Working with PageMaker

Selecting Document Styles

Defining Printer Styles

Figure 2-3: Click on Edit

Figure 2-4: Select Pages
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Tip: The Both Pages box allows the option of printing all pages or selecting even
or odd pages only. You may also choose to print only selected pages, by entering
those page numbers in the Ranges box.

Working with PageMaker

Selecting Document Styles

Options:

1 2

3

3.  For a file that reads like a book, with facing pages, select Reader’s Spreads. For
a standard report, deselect Reader’s Spreads.

1
2

4.  Select print blank pages only if you want any blank pages in your document to
appear in your PDF.

Select Reader’s Spreads for a
book format.

Deselect Reader’s Spreads for a
report format.

You can choose to
create a PDF of only
the even or the odd
pages in your report.

You may create a
PDF of only

selected page
numbers.

Figure 2-5: Page Options

Figure 2-6: Reader’s Spreads

Figure 2-7: Print Blank Pages
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1. Select your paper size. Options include letter, legal and more.

Selecting Document Styles

Working with PageMaker

Choosing Paper Styles

Standard,
vertical report

Wide, horizontal
report

5.  Select the orientation of your report – horizontal or vertical. For most reports,
select vertical.

6. In the menu on the right, select Paper.  This will bring up the next screen, the
Print Paper Screen.

Figure 2-8: Select Orientation

Figure 2-9: Select Paper

Figure 2-10: Select Paper Size
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Working with PageMaker

Tip: You may customize the size of your PDF by selecting Custom in the Size box.
When you select Custom, an options screen will open to allow you to enter page
dimensions. The graphic on the right will help you determine how the finished
product will fit on the page.

Choosing Paper Styles

Selecting Custom allows
you to set your own page
size.

The
graphic

indicates
how the
finished
product

will
appear.

Standard Settings

2.  For a standard report or class assignment, use the following settings: Set Source
to Only One; Deselect Printer’s Marks and Page Information. Tiling should be set
at None; and Scale should be set at 100%.

Figure 2-11: Select Custom Size

Figure 2-12: Standard Paper Settings
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Tip: If you are preparing a PDF for production on a commercial press, you may
want to select Printer’s Marks and Page Information. Before beginning a PDF for a
printer, you should contact the vendor for details on page size and additional
options.

You may adjust the size of your publication slightly by selecting Reduce to Fit
instead of 100%.You may also create thumbnails by selecting the Thumbnail
option and indicating how many thumbnails you would like on each page.

Choosing Paper Styles

3.  Select Options. This will bring you to the next screen, the Print Options Screen.

These settings
may be used
when preparing a
PDF for a
printer.

You may reduce
your document’s
size or create
thumbnails by
selecting these
options.

Working with PageMaker

Figure 2-13: Additional Options

Figure 2-14: Select Options
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Working with PageMaker

Selecting Print Options

1.  For a standard assignment, the entries should read as follows - Send image data:
Optimized subsampling; Data encoding: Send binary image data; Download fonts:
PostScript and TrueType.

2.  Select Write PostScript to File. In the rectangular box, type in the name of your
PDF. Click on Save As... to indicate where you want to save the PDF.

Name Here

3.  Click on the Color button on the list. This will bring you to the next screen, the
Print Color Screen.

Figure 2-15: Write PostScript to File

Figure 2-16: Click on Color
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Tip: If you are preparing a PDF for use by a vendor (commercial press), you may
want to select Separations instead of Composite. Check with the vendor before-
hand to determine the settings required.

1.  Select Composite and Color.

Choosing Color Options

Working with PageMaker

Print

If preparing a PDF for a commercial press:

Print

Figure 2-17: Select Composite and Color

Figure 2-18: For Commercial Press
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Working with PageMaker

Choosing Color Options

Print

Exporting the PDF

2.  Click on Print.

3.  This completes options selections and brings you back to your PageMaker File.

Now that you have indicated preferences for your project, you are ready to export
the PDF. When you complete the following steps, PageMaker will create a
postscript file incorporating the preferences you selected. You will then use
Acrobat Distiller to translate the postscript file into a PDF.

1.  Under the File Menu in PageMaker, select Export Adobe PDF. This will bring
up the Export Adobe PDF screen.

2. Select Distill Now.

Figure 2-19:  Complete Options Selections

Figure 2-20: Distill Now
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Working with PageMaker

Exporting the PDF

3. Under Printer Style, the drop-down menu lists a selection of styles. Choose the
style you created earlier (Pages 5-6 of this manual, Defining Printer Styles).

4.  Under page size, select same as printer style.

5.  Under pages, select all.  (You may select ranges if you want to create PDFs of
selected pages only).

Select the
printer style
you created
earlier.

Figure 2-21: Select Printer Style

Figure 2-22: Select Pages or Ranges
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Exporting the PDF

Working with PageMaker

6.  Click on Export.

For Additional Options:

Or

Tip: In selecting additional options for the Color Model, choose RGB display for a
document to be viewed on the web. CMYK is best used when a document is to be
sent for production by a commercial press.

Tip: A number of options in exporting the PDF can be found by selecting Next in
the Exporting PDF menu, or by using the drop-down menu at the upper left.
Among these options are requesting embedded fonts, changing graphics resolution,
selecting color model, and preferences for Adobe Distiller.

Figure 2-23: Export

Figure 2-24: Exporting Options Figure 2-25: Color Model
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Exporting the PDF

Working with PageMaker

8.  A Save Menu will pop up. Name your PDF in the box provided and click Save.

Name Save

Tip: The drop-menu at the top of the screen allows you to choose where to save the
file. Note where you are saving the file. For easy retrieval, save to Desktop. You
can move the file later into the appropriate folder.

Dropdown menu allows you
to choose where to save the
file.

7.  A Printer Style Conflicts Menu will pop up. Click O.K.

Figure 2-26: Printer Styles Conflicts Menu

Figure 2-27: Naming the PDF
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Exporting the PDF

Working with PageMaker

9. PageMaker will begin creating a postscript file. A screen will appear indicating
the progress as the file is created.

10. You are ready to begin distilling the file using Adobe Acrobat Distiller.

Figure 2-28: Generating Postscript File
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Working with Acrobat Distiller

1.  Open Acrobat Distiller.

2.  In the Distiller File Menu, highlight your postscript file and then select Open.

3. Distiller will begin creating the PDF from the postscript file.

Select and open
your postscript

file.

Distilling the PDF
Depending on the preferences when the software was installed, Acrobat Distiller
may automatically open and begin creating the PDF as soon as the postscript file is
complete. If this does not occur, follow the steps below.

Click
Pause or
Cancel to
stop
distilla-
tion.

4.  A box will appear indicating that distillation is taking place. You may
pause or cancel the job.

Figure 3-1: Open Postscript file

Figure 3-2: Pause or Cancel
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Viewing the PDF

Working with Acrobat Reader

1. When distillation is complete, the PDF icon for your file will appear. You can
find the PDF on the desktop, or in the folder where you saved the postscript file.

2.  Open Acrobat Reader, select your PDF and click on Open.

Double-click the PDF icon
to open.

Tip: You may also open your PDF by double-clicking on its icon.

Your PDF is now complete and ready for viewing. You can view your PDF using
Acrobat Reader. If you find mistakes in your PDF, return to PageMaker and make
corrections, then create a new postscript file and repeat the distillation process.

Figure 4-1: Open the PDF

Figure 4-2: PDF Icon
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Working with Acrobat Reader

2.  In the Acrobat Reader menu, select View to adjust the size of your page on the
screen to your preference.

Tip:  The Fit in Window option shows the entire page at a glance. Actual size will
preview your document as it would be printed, and Fit Width will provide a larger
screen view. You may zoom in or out of various locations on the page, and view
the report as either consecutive single pages, or as one continuous document.

Viewing the PDF

Figure 4-3: View Options
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Creating a PDF can be a complicated process and sometimes the end result is not
exactly what you had in mind. The following questions and answers address
common difficulties encountered with creating a PDF. In most cases, you will have
to return to PageMaker to correct the difficulties and then create a new PDF.

Q:   Why does my report exceed the margins on my page?

A:   You may have selected an inappropriate paper size. Go to the section on
choosing paper styles (page 8), and check your paper size. You may customize
your size to create the page size you prefer, or select reduce to fit, so that your
document will fit the page.

Q:   Why did it change some of my fonts to a different typeface?

A:   Go to the Print Options menu (see page 11), and check to see that Download
Fonts: PostScript and TrueType is selected. If it is not selected, PageMaker may
make its own substitutions for fonts you use that it does not recognize.

Q: Why do the photographs in my report look so fuzzy?

A: If you place photographs in a PageMaker document and then resize them, they
may show up fuzzy in your PDF. Determine the size you need for your photograph
and resize it using Adobe Photoshop, or other appropriate software. Then place the
properly sized photograph into your document. Also, check your resolution in the
Export Adobe PDF options by choosing Compression on the dropdown menu (see
page 15).  Under Compression, check to see that your resolution is set to “Same as
Original.”

Troubleshooting

Resolution should
be set to Same as
Original.

Figure 5-1: Compression
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Troubleshooting

Q:  I have completed distillation but cannot find the PDF. Where can I find
the file?

A: If you did not indicate that Acrobat should save the PDF to the desktop (see
page 16), then it most likely saved the file in the folder where you saved the
PageMaker document used to create the PDF. Look in that folder for the PDF icon.
Sometimes it takes a moment after distillation is complete for the PDF icon to
appear.

Q:  I wanted to create my report in book format, with pages 1 and 2 facing
each other. The PDF placed page one on the front page, and put pages 2 and 3
as facing pages.  How can I correct this?

A:  Return to PageMaker and Insert a Blank Page at the beginning of your docu-
ment. This will align pages 1 and 2 as facing pages. You may choose not to in-
clude the blank page in your PDF. (see page 7).

Q:  When I preview my PDF with Acrobat Reader, I can only see part of the
page. How can I see the entire page at once?

A:   In the Acrobat Reader menu, choose View and select Fit in Window (see page
20).

Q:  How do I make corrections in the PDF?

A:  In many  cases, you cannot edit the PDF once it is created. You will have to
return to PageMaker to edit, then create a new PDF. Some expanded versions of
Acrobat Reader may allow you to edit the PDF.
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Glossary

ASCII - a format used to save graphics in
postscript files, used on Windows platform.

Binary image data - a format used to save
graphics in postscript files, use with Macintosh.

Book Format - a document with facing pages
that reads like a book.

CMYK - a type of color image best suited for
production by a commercial press.

Commercial press - a vendor who prints publi-
cations on large printing equipment.

Composite - Color option which prints all colors
at once on the publication.

Data encoding: a format used to save graphics
in postscript files - binary image data is used on
the Macintosh, and ASCII is used on Windows.

Distillation - the processing of translating a
postscript file into a PDF.

Downsampling and subsampling - reduces the
size of images by reducing the resolution to a
specific setting. Some quality may be lost.

Dropdown menu - a menu with other options
shown by clicking on an arrow, the menu will
then expand (drop down) to show the other
options.

Embedded fonts - an option to include the fonts
you use in your PDF, if not embedded, Page-
Maker may make substitutions for fonts a reader
doesn’t have, which may affect your layout.

PDF - Portable Document Format.

PostScript Fonts - standard fonts included in

Postscript printer descriptions.

Postscript printer - the printer used by
PageMaker to create the postscript file.

Printer’s Marks - crop and bleed marks used by
printers with a commercial press.

Ranges - an option to select only certain pages,
for example Ranges 2 - 4, would print pages 2, 3,
and 4.

Reader’s Spreads - a report format with facing
pages that reads like a book.

Resolution - refers to number of dots per inch in
a graphics file - higher resolution is a larger file
with better quality.

RGB - a type of color image best suited for
viewing on the web.

Scale - reduces a large publication to fit on a
page.

Separations - Color option which prints selected
colors on a separate film for each color.

Thumbnails - samples, a selection of sample
pages in a small size, usually several on a page.

Tiling - when a publication is too large to print
on a standard printer, PageMaker will Tile the
pages, creating several pages that can be fitted
together.

Truetype fonts - non-postscript fonts, descrip-
tions not included on a standard postscript
printer.

Virtual Printer - a postscript printer used by
PageMaker to create the postscript file.
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Appendix 2:  Advanced Tips

Bookmarks for online use: If you create an index in PageMaker using the Index
Entry option (under the Utilities menu), PageMaker can create a hyperlink marker
in front of the index topic. When the PDF is viewed online, the marker should
allow readers to click to the subject. You can set options in the Export Adobe PDF
menu options by selecting the Bookmarks section. For table of contents book-
marks, select Create TOC Bookmarks. For index bookmarks, select Create Index
Bookmarks. In the Hyperlinks section, select preserve table of contents links, and/
or preserve index links. You can also preserve internal links to include hyperlinks
you specified as anchors within the text of the publication.

Appendices

Figure 6-1: Export Links

Figure 6-2: Bookmarks
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Numbering pages: Page numbers may not translate properly from PageMaker to
PDF if you use Roman Numerals for beginning pages. The PDF will view your
cover page as page one, and all other pages sequentially, disregarding the Roman
Numerals. This could cause difficulty with index and table of contents information.

Saving Adobe Export Options: You may save option selections made in the
Adobe Export menu to avoid having to repeat them. To save options you selected
in the Export Adobe PDF menu box:

1. Select File, Export, Adobe PDF.
2. Set the options you prefer.
3. Click on Save Settings.

To recall these settings:
1. Select File, Export, Adobe PDF.
2. Select Load Settings.
This will reinstate the options you chose in the Export Adobe PDF menu box.

Fonts and Subsets: Including downloadable fonts insures that any reader regard-
less of platform will see your document as you intended. If fonts are not embedded
(See Export Adobe PDF options), PageMaker may substitute an approximation of
the font you selected, which could create problems in your layout. If embedding
fonts creates an unnecessarily large file, you may choose to embed a subset of the
font you are using, and PageMaker will embed only those characters used in the
publication (for example, Normal, Bold and Italic).

Appendix 2:  Advanced Tips

Appendices

Online Color: For consistent color online, choose from the Online Colors available
in PageMaker. These colors will be consistent in all browsers. To choose online
colors, choose Utilities, Define Color, and click New. Then choose Online Colors.
Shift to select multiple colors.

Compiling Several PageMaker files into One PDF: You can compile several
files into one, to make it easier for online access, by selecting Utilities, Book, and
choosing the files you want to add. You can determine the order in which files will
appear with the Move Up or Move Down option. To combine the files into one
PDF, select Export Adobe PDF, and choose Same as Current Publication under
Page Size. Choose Apply Settings of Each Publication if documents are different
sizes.
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Cover photo downloaded from www.freefoto.com.
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